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Abstract 
To ensure effective nutritional surveillance of athletes on a national scale, it is 
essential to collect reliable and representative data on dietary intakes. This re-
quires the design and validation of standardised tools that are regularly up-
dated to reflect recent changes in the composition of food products and the 
nutritional habits of the population. The aim of this study was to create and 
validate a digital tool designed to assess the dietary profiles of elite Chadian 
martial arts practitioners. A total of 63 elite Chadian martial artists (33 men 
and 31 women) with an average age of 18.58 ± 2.36 years participated in this 
study. Anthropometric parameters, including height, body weight and body 
mass index (BMI) were measured. To validate the Food Survey software pack-
age, energy, macro- and micronutrient intakes were assessed using a 24-hour 
food intake recall (reference method) and compared with the same data col-
lated from Food Survey (tested method) in order to analyse reconciliation 
agreements between the results of the two methods. The comparison of energy 
and nutrient intakes for women and men revealed similar results for most nu-
trients, indicating overall consistency. Analyses of the various Bland-Altman 
distribution curves indicate that the majority of the parameters from the two 
methods studied show good agreement: the biases (y = absolute bias) are, for 
the most part, perfect, with most of their values close to 0. The limits of agree-
ment (y = absolute bias ± 1.96 × standard deviation) are also narrow for all the 
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data analysed, with the exception of phosphorus (−371.299; 250.113). This IT 
tool represents an innovative alternative for assessing food choices, particu-
larly in contexts where dietary behaviour is measured only once. Unlike 24-
hour dietary recalls or food frequency questionnaires, which require repeated 
administrations to provide a more comprehensive assessment of dietary hab-
its, this tool stands out for its ability to be effective in studies with limited time 
and budget. It is a practical solution for rapidly collecting reliable data on food 
choices in constrained research environments. 
 

Keywords 
Digital Tool, Validation, Nutritional Intake, Dietary Survey, Combat Sport 

 

1. Introduction 

Nutrition plays a crucial role in sports performance, directly influencing physical 
capacity, recovery and endurance. For elite athletes, a balanced diet adapted to the 
specific requirements of their discipline is essential to optimise their performance 
[1]-[4]. Accurate assessment of dietary intake is therefore essential to help athletes 
make informed decisions about dietary recommendations for athletes.  

Several methods are used to assess diets, each with its own advantages and lim-
itations. Commonly used tools include 24-hour dietary recalls, food frequency 
questionnaires (FFQs), food diaries and direct observations [5]-[7]. These meth-
ods make it possible to obtain qualitative and quantitative data on people’s eating 
habits. For example, food recalls provide a snapshot of food consumption, but are 
highly dependent on the memory and sincerity of the respondent. FFQs, on the 
other hand, provide an overall view of dietary trends over an extended period, 
although they are often biased by reporting errors. 

In recent years, however, a number of food survey tools have been designed and 
validated using computer software, the Internet and the Web, thanks to the work 
of leading researchers. These tools are now used worldwide [8]-[11]. Although 
these technological innovations do not guarantee greater dietary accuracy than 
traditional dietary assessment methods, they offer interesting prospects for minimis-
ing dietary reporting bias [8].  

The majority of researchers working on new dietary survey technologies validate 
them by relying on traditional reference tools and methods, such as the 24-hour 
dietary recall or the food frequency questionnaire, combined with statistical analyses 
[8] [12]. These tools also seem unsuitable for certain countries, due to the wide range 
of environmental factors that determine dietary behaviour [13]. 

In the Chadian context, assessing the diets of elite athletes faces several challenges. 
Limited resources, restricted access to country-specific dietary databases, and cul-
tural and regional variations in dietary habits complicate the application of stand-
ard methods. In addition, Chadian sportsmen and women live in an environment 
where sports facilities and nutritional resources are often inadequate, making un-
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derstanding their needs even more critical. 
This problem highlights the importance of choosing assessment tools that are 

adapted to the local context. The integration of modern technologies, such as mo-
bile applications for dietary monitoring, could offer a promising solution for col-
lecting accurate data while overcoming some of the limitations of traditional 
methods. It is also essential to train athletes and their coaches in the basics of 
sports nutrition so that they can better understand the impact of their dietary 
choices on their performance. The aim of this project was to create and validate a 
digital tool designed to assess the dietary habits of elite martial arts practitioners 
in Chad. This new tool will also be validated using more sophisticated methods 
such as isotopes and accelerometers. 

2. Material and Methods 
2.1. how Food Survey was Developed 

Preliminary investigations using the Food Frequency Questionnaire (FFQ), carried 
out in accordance with international and scientific database standards, enabled us 
to draw up a booklet of food portions. To this end, 10 food groups (cereals; tubers; 
legumes; vegetables; fruit; meat; fish and eggs; dairy; oils and fats; beverages and 
other foods) comprising 190 foods were identified. Units of measurement were also 
listed: kitchen utensils (ladle, soup and coffee spoon, piece of carved calabash, 
glass...) and others (coins and banknotes, pinch of fingers, wrist of hand, palm of 
hand...). An electronic dietary scale with a capacity of 5 kg, brand Téfal, and model: 
copper 5 and accuracy 1 g, test tubes, beakers etc. and a camera were used for this 
purpose. The raw foods were weighed by Nutritionists assisted by students from the 
National Institute of Younth and Sports of N’Djamena and photographed by a pro-
fessional photographer directly with women market vendors, in food stores or in 
households in the study area (3, 6, 7, and 9th Arrondissement of N’Djamena Com-
mune). A portion of food corresponds to the standard unit of measurement or its 
equivalent (coin) customary in Chad for each foodstuff. For cooked foods, the re-
search team weighed and photographed some purchased from vendors, informal 
traders and restaurateurs, and others prepared in the households selected for the 
occasion. In the case of multi-ingredient dishes, for example, the “bouillie compo-
sée”: a Chadian dish whose gross weight is measured and estimated at 700 g of its 
portion, containing the standard unit of measurement commonly known as a “go-
belet”. The net weight of the main ingredient, grain rice, is estimated at 66g. Added 
to this is water, calculated and estimated at 517 g, cow’s curd (57 g), peanut paste 
(20 g) and sugar (40 g). Portions of main and accessory ingredients are quantified 
using the Dop method [8]. Measurements are carried out a minimum of three times 
in different locations for the same foods, in order to retain the average values, which 
are recorded in the “Food Survey”. 

2.2. How Food Survey Works 

The Food Survey application facilitates the assessment of dietary intakes in four 
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main stages, illustrated by the figures shown. 
 

 
Figure 1. Home page. 

 

 
Figure 2. File/Edition menu. 

 

 
Figure 3. File sub-menu. 

 

 
Figure 4. Registration of sud-menus. 

 

 
Figure 5. Menu edition. 
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Figure 6. Registration of respondents. 

 

 
Figure 7. Entering a food. 

 

 
Figure 8. Parameter analysis. 

 
Double-click on the Food Survey icon to open the main screen (Figure 1). Then 

click on the File/Edit menu (Figure 2). 
1) Managing sub-menus in the File menu 
Selecting the File menu gives you access to various sub-menus (Figure 3) such 

as the unit of measurement, meal types or the food composition table. To save a 
data item (for example, a unit of measurement), enter the necessary information, 
add an image if you wish, then click on Add to confirm (Figure 4).  

2) Accessing the Edit menu  
Click on Edit to display the sub-menus (Figure 5), such as Entering respondent 

information and Dishes served. Before any analysis, identify the respondents by 
filling in their information in the corresponding sub-menu (Figure 6).  

3) Entering meals and analysing data  
For each food consumed, enter the respondent, the meal (breakfast, lunch, din-

ner, etc.), the quantity and click Save (Figure 7). Finally, to calculate the energy 
and nutrient intakes, go to Data analysis, select the dishes served, and validate to 
obtain the cumulative results in energy, macronutrients (proteins, lipids, carbo-
hydrates) and micronutrients (Calcium, Iron, vitamins, etc.) as shown in figure 
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8.2.2.  
Indeed, the algorithms are based on the data contained in the food booklet, i.e. 

the food portion and its ingredients, the unit of measurement and the weight of 
each ingredient, combined with a food conversion sheet for macro and micronu-
trients per 100g of edible food. From this food portion, the rule of three is applied 
according to the quantity of food ingested by the subject, and recorded to deter-
mine the lipid, protein and carbohydrate content in g, the Calcium, Iron and 
Phosphorus content, and the vitamin B1, B2, B6 and C content in mg. Energy 
intake is then calculated by multiplying the cumulative content of carbohydrates 
in g by 4 Kcal, protein in g by 4 Kcal and lipids in g by 9 Kcal, according to the 
standards for converting g into Kcal for these substrates. Energy intake is the sum 
of the three results. For Calcium, Iron, Phosphorus and vitamins, the total consti-
tutes the subject’s intake. 

2.3. Validation of the Food Survey Tool 
2.3.1. Participants and Sample Size 
The study carried out in 2021 involved a group of 63 practitioners of combat 
sports: Taekwondo (n = 26), Wrestling (n = 14), Karate (n = 13) and Judo (n = 
10) in preparation for the African Games in Brazzaville. According to a statistical 
estimate carried out using the G*Power programme for four sports disciplines, 
the minimum sample size required, with a significance level of 0.05 and statistical 
power of 0.95, should be between 76 individuals (for strong effects) and 92. 

The selection criteria for participants included competitive practice of a combat 
sport at the highest level of the federation in Chad and at least three years’ expe-
rience. Conversely, exclusion criteria included a low level of sporting perfor-
mance, less than three years’ professional experience or an injury-related inter-
ruption in training.  

The research was conducted in accordance with the ethical principles of the 
1964 Declaration of Helsinki. Informed consent was obtained from all partici-
pants. The protocol was approved by the Ethics Committee (reference no. 
101/LBT/OIL/2021, dated 11 April 2021). 

2.3.2. Study Design 
A team consisting of a nutritionist and a professional photographer collected data 
over a four-week period. They used a food frequency questionnaire [14] to iden-
tify the main foods consumed. A booklet containing photos of food portions, their 
standard household measurements, their gross weights and the ingredients that 
make them up was produced [15]. Equipment such as a dietary scale, experiments 
and a camera were used for this task. 

In the absence of a food composition table for use in Chad, a rigorous compi-
lation of data from existing tables in accordance with FAO/INFOOD guidelines 
was used to create the databases. The conversion of food into macronutrients 
(proteins, lipids, carbohydrates), vitamins (B1, B2, B6, C), minerals (Calcium, 
iron, phosphorus) and energy was carried out using the improved FAO food table 

https://doi.org/10.4236/ijis.2025.152004


A. Moyengar et al. 
 

 

DOI: 10.4236/ijis.2025.152004 85 International Journal of Intelligence Science 
 

for use in Africa [16], the Souci table (2004), data from the US Department of 
Agriculture [5], the Department of Health of England [17], studies by [18], as well 
as the food composition table for countries in the Congo Basin [19] and West 
Africa. The results of scientific publications on food content in Chad’s neighbour-
ing countries (Cameroon, Nigeria) are also included. For local foods whose com-
position does not appear on the tables identified, the results of physico-chemical 
analyses of local foods are carried out at the N’Djamena biochemical laboratory: 
CECOQDA (Centre de Contrôle des Qualités des Denrés Alimentaires) and the 
Pointe-Noire laboratory in Congo. 

A computer engineer has designed an innovative application called Food Sur-
vey, which integrates food data and photographed portions. The tool can be used 
to record and project data to help participants make their choices. This comput-
erised, dynamic and adaptable application modernises traditional methods such 
as the 24-hour dietary recall. 

Two research teams worked simultaneously for 7 days. The first, made up of a 
nutritionist and trained students, conducted surveys using the classic 24-hour re-
call method. It recorded the names of the foods, their quantities (using household 
measurements such as a ladle or cup), the ingredients, as well as the times and 
types of meal. Three non-consecutive days were chosen to minimise errors. 

The second team, also led by a nutritionist and assisted by students, used the 
Food Survey. The data was projected onto a screen, and the participants made 
their choices directly. This tool overcomes the challenges associated with quanti-
fying food, managing collective meals and the errors of manual methods. 

2.3.3. Measures 
Data were collected using a structured questionnaire, completed independently 

by the participants. The questionnaire included information on socio-demographics, 
weight, height and body mass index (BMI), in accordance with the usual meas-
urement standards.  

1) Anthropometry 
Anthropometric data were collected using precise, standardised protocols from 

barefoot and lightly clothed athletes. Body mass was measured using a digital im-
pedance meter (Tanita brand model: BC-545) with an accuracy of 0.1 kg, and height 
was measured using a portable stadiometer (Sanny brand, American Medical of Bra-
zil) with a maximum height of 2.20 m and an accuracy of 0.1 cm. BMI in Kg/m2 was 
calculated using the Quételet formula: BMI= [Weight (kg)/Height2 (m)]. 

2) Dietary profile  
The 24-hour recall questionnaire was completed by each athlete on a self-report 

basis on non-consecutive days. It covered the food and drink consumed the pre-
vious day. To promote accurate recall and limit potential bias, detailed written 
instructions were provided to the athletes prior to completion. 

2.4. Statistical Analysis 

The data were analysed using SPSS 21.0 and STATA 14 software. Firstly, a t-test 
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for independent samples was used to assess the differences in indices between the 
various types of addicts. The Bland-Altman plot was used to assess the agreement 
between the values recorded in the RA24H and Food Survey methods. The 
Shapiro-Wilk test confirmed that the data followed a normal distribution (P > 
0.05). The threshold for statistical significance was set at α = 0.05. 

3. Results 

A total of 63 combat sports athletes took part in the study, 49.2% of whom were 
women and 50.79% men. The average age of the participants was 15.58 ± 2.36 
years, with a height and body mass index of 1.69 ± 0.04 m and 21.79 ± 2.27 kg/m2 
respectively. The athletes came from a variety of specialities, including taekwondo 
(41.26%), wrestling (22.22%), karate (20.63%) and judo (15.87%). 

 
Table 1. General characteristics of participants. (n = 63) 

Variables m ± SD n (%) 
Gender   
- Men’s  32 (50.79) 
- Ladies  31 (49.20) 

Speciality   
- Taekwondo  26 (41.26) 

- Lutte  14 (22.22) 
- karaté  13 (20.63) 
- Judo  10 (15.87) 

Age (years) 18.58 ± 2.36 / 
Height (m) 1.69 ± 0.04 / 

BMI (kg/m2) 21.79 ± 2.27 / 

 
Table 2 compares mean energy and macronutrient intakes between female (n 

= 31) and male (n = 32) participants obtained using two assessment methods: 
RA24h (24-hour dietary recall) and Food Servey. These two assessment methods 
showed very similar results for most nutrients, suggesting overall consistency. The 
greater variations for certain micronutrients, such as iron, Calcium and Phospho-
rus in women, may reflect greater sensitivity of the data to the method used. The 
variations in vitamin C in men, with a notable drop in Food Servey, merit further 
exploration. 

 
Table 2. Energy, macro- and micronutrient intakes of participants. 

 Ladies (n = 31) Men’s (n = 32)  
 RA24h Food servey ∆ (%) RA24 h Food servey ∆ (%) 

DEI (kcal) 2665.54 ± 257.0 2667.43 ± 250.5 0.07 3414.44 ± 210.2 3470.89 ± 316.76 1.65 
Proteins (g) 96.72 ± 27.69 98.12 ± 26.06 1.44 123.89 ± 23.61 124.12 ± 23.95 0.17 
Lipids (g) 84.01 ± 30.0 82.72 ± 28.56 1.53 113.48 ± 34.02 117.95 ± 36.06 3.93 

Glucides (g) 380.37 ± 80.24 382.61 ± 79.75 0.58 474.38 ± 84.75 478.22 ± 87.93 0.80 
Calcium (mg) 337.52 ± 133.85 362.18 ± 185.32 7.83 411.11 ± 122.67 417.29 ± 108.41 1.50 

Fer (mg) 20.78 ± 4.54 22.54 ± 4.05 8.49 27.27 ± 5.79 27.37 ± 5.41 0.28 
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Continued  

Phosphore (mg) 1401.54 ± 309.1 1524.52 ± 573.0 8.77 1777.51 ± 399.8 1777.55 ± 376.9 0.002 
Vitamine B1 1.13 ± 0.25 1.22 ± 0.19 8.42 1.55 ± 0.30 1.52 ± 0.24 2.57 
Vitamine B2 1.95 ± 0.44 1.91 ± 0.48 2.10 2.43 ± 0.87 2.46 ± 0.82 1.19 
Vitamine B6 2.14 ± 0.45 2.19 ± 0.47 2.56 2.84 ± 0.79 2.82 ± 0.72 0.63 
Vitamine C 114.68 ± 45.0 115.95 ± 45.82 1.09 146.12 ± 54.13 136.54 ± 54.27 6.5 

 
The figures in the tables are expressed as averages ± standard deviations and as 

percentages. ∆: difference between the values recorded by the RA24h (24-hour 
recall) and Food Survey; DEI: daily energy intake 

Bland-Altman curves of energy-adjusted carbohydrate, protein, and fat intakes 
between methods are presented in Figure 9(a)-Figure 9(c). The reported intakes 
were within the limits of agreement for most individuals; however, the differences 
between methods appeared to be greater at moderate levels of intake Figure 9(a). 
The bias value (zero mean difference) is −0.802 close to zero, a perfect but negative 
bias (−0.802), which means that the Food Survey (new method) underestimates 
the series by 0.802 g (negligible) of protein compared with RA24h (reference 
method). Intakes adjusted for fat content Figure 9(b) and carbohydrate content 
Figure 9(c) showed acceptable agreement. 

 

 
(a) 

 
(b) 
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(c) 

Figure 9. Bland-Altman plot of protein (a), fat (b) and carbohydrate (c) intakes of all 
Chadian martial arts practitioners (n = 63). The graphs present the mean difference be-
tween the two methods and the limits of agreement at 95%.  

 
The Bland-Altman curves of mineral content; Calcium, Iron and Phosphorus be-

tween methods are presented in Figure 10(a)-Figure 10(c). Reported intakes were 
within the limits of agreement for most individuals; however, differences between 
methods appeared to be greatest at moderate levels of intake Figure 10(b). Calcium 
Figure 10(a) and phosphorus Figure 10(c) intakes showed acceptable agreement. 

 

 
(a) 

 
(b) 
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(c) 

Figure 10. Bland-Altman plot of Calcium (a), Iron (b), and Phosphorus (c) intakes of all 
Chadian (((martial arts practitioners (n = 63). The graphs present the mean difference be-
tween the two methods as well as the agreement limits at 95%.  

 
The Bland-Altman plots of Vit B1, Vit B2, Vit B6 and Vit C intakes between the 

methods (RA24H and Food Survey) are presented in Figure 11(a)-Figure 11(d). The 
reported macronutrient values were within the limits of agreement (y = absolute bias 
± 1.96 × S.D) for most individuals. However, the differences between the methods 
appeared to be greater at more moderate levels of intake Figure 11(a). Energy-ad-
justed intakes of Vit B2 (Figure 11(b) and Vit B6 (Figure 11(c)) and Vit C Figure 
11(d) showed acceptable agreement, while agreement for Vit B1 intake (Figure 
11(a)) was higher between methods (i.e. 15% outliers of the 95% limits of agreement). 

 

 
(a) 

 
(b) 
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(c) 

 
(d) 

Figure 11. Bland-Altman graph of vitamin B1 (a), B2 (b), B6 (c) and vitamin C (d) levels 
in all Chadian martial arts practitioners (n = 63). The graphs present the mean difference 
between the two methods and the limits of agreement at 95%. 

4. Discussion  

The aim of this study was to create and validate a digital tool designed to assess 
the dietary habits of elite Chadian martial arts practitioners. The results show that, 
with regard to the Bland-Altman diagrams of the various parameters investigated, 
all the points are homogeneously dispersed around the lines averaging the differ-
ences in all the parameters (AEJ, macro and nutrients) with limits on either side 
of zero representing the upper and lower limits of agreement at 95%. This suggests 
that energy, mineral and macronutrient intakes were in normal agreement be-
tween the two methods: Food Survey (new) and RA24h (reference).  

Comparison of energy and macronutrient intakes between female (n = 31) and 
male (n = 32) participants obtained by the RA24h and Food Servey showed very 
close results for most nutrients, suggesting overall consistency. The greater varia-
tions in certain micronutrients, such as iron, calcium, and phosphorus in women, 
could reflect a greater sensitivity of the data to the method used. However, the 
variations in vitamin C in men, with a notable drop in Food Servey, merit further 
exploration. 

These energy values are similar to those found in the [20] study of archery ath-
letes. For these authors, these nutritional loads correspond to the daily physical 
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loads of archers. This implies that the values recorded from the Food Survey are 
not sufficiently biased. Our results are in line with those of a recent study which 
suggested that Bland-Altman diagrams revealed no systematic bias concerning 
energy, protein, fat or carbohydrate intake [21]. For these authors, the data col-
lected via the IOS application can be exploited to assess the distribution of food 
consumption within a target group. On the basis of these results, it appears that 
IOS data could be used effectively to monitor dietary habits on campus, in partic-
ular to identify sub-groups with potentially insufficient or excessive dietary intake. 
However, this method is not suitable for directly comparing observed dietary in-
takes with absolute dietary recommendations.  

The results obtained using the Blan-Atman method for vitamin B2, B6 and vit-
amin C intake showed concordant intakes on average for both methods, as re-
ported by other authors [22]. These authors suggest that the Bland-Altman dia-
grams showed no serious bias for any of the 25 nutrients examined by the FFQ 
and RA24h. However, the vitamin B1 intake values showed higher mean intakes 
for Food Survey than those reported by RA24h. This trend may be explained by 
the fact that participants under-reported vitamin C intakes in the RA24h method 
compared with the Food Survey. Previous studies have reported similar results 
[23] [24]. 

However, the findings of the present study contrast with those of the study by 
[25] on the validation of an online quantitative food frequency questionnaire to 
assess dietary intake in the adult Emirati population. These authors reported in-
consistent agreement in the validation of the 2 methods used with a moderate level 
of validity for most nutrients after analysis of the Bland-Altman diagram. Previous 
research has reported significant variability in the validation of dietary assessment 
methods for estimating nutrient intake. The Bland-Altman diagrams reported 
showed limited and inconsistent agreement, with no significant advantage over 
other approaches used to assess nutrient intake in the same studies [26]-[28]. A 
study by [20] investigated the use of the online dietary assessment tool Riksmaten-
Flex in Swedish adolescents. The results showed that the energy intake reported 
via this tool was higher than that obtained using the traditional 24-hour dietary 
recall interview method (reference tool). As a result, macronutrient intakes were 
also higher with RiksmatenFlexDiet. This highlights a low level of agreement be-
tween the two methods, in contrast to the high level of agreement observed be-
tween the validated Food Survey method and the RA24H for the same parameters. 

This difference in validation levels can be explained by the context in which 
each method is applied. The Food Survey approach, carried out in a collective 
setting, allows better control of the survey process, thus reducing potential bias. 
On the other hand, the individual nature of the survey carried out with Riks-
matenFlexDiet may lead to reporting bias, particularly due to difficulties in check-
ing the information entered by the participants themselves. 

The Food Survey offers several notable advantages. First of all, it has the particu-
larity of associating a computerized composition table and the photography of foods 
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and their units of measurement with a “software package” housing the algorithms 
allowing to obtain the automatic results of individual food consumption surveys in 
a community diet. Advantageous, also because each subject can, based on their usual 
consumption, have a mental representation of the portions of food consumed and 
make a connection with those of the photographs to solve the problem of the indi-
vidual quantification of rations during collective meals common in Chad where sev-
eral people share the same meal in a single dish. Then, it takes into account in the 
calculations, the nutrient content of each ingredient in the mixed dishes. The con-
sideration of traditional units of measurement in digital technology reconciling cul-
tural values with new information and communication technologies (NICT) is also 
put in the asset of this new tool. Finally, the Food Survey stands out from other 
technological tools in use today by its dynamic profile, unlike the latter which are 
static, limited in time and space of their maneuvers. It has the capacity to modify 
the parameters in existing databases, record new data to complete or reconstruct 
existing ones. It has the privilege of being operational at all times and in all places. 

Although this study provides valuable and still little-explored data, it has certain 
limitations that deserve to be highlighted. First, The study focused on a small sam-
ple of elite Chadian combat athletes, which makes it impossible to generalize the 
results to all Chadian athletes and other populations. For this reason, a study with 
a representative and inclusive sample of the entire sporting and/or non-sporting 
population would be desirable. Second, the data collection took place at a specific 
time of the season (the pre-season), a period when weight management require-
ments are often less strict than during competition periods. Furthermore, only 
certain age categories were included, which could mask potential differences in 
nutritional needs among young athletes. Thus, future research should verify 
whether the conclusions of this study are valid for all sports and for various age 
groups. Finally, conducting a study with large samples would allow for further 
generalization of the use of this tool to all Chadian athletes. 

5. Conclusion 

The data show overall consistency between the two methods (RA24h and Food 
Servely) for the majority of macronutrients. Differences between methods remain 
overall small for most parameters (<5%), indicating that and RA24h produce sim-
ilar results. This reinforces the reliability of Food Servely methods for estimating 
mean energy and nutrient intakes of Chadian martial arts athletes. Developing 
dietary assessment methods to achieve a limited degree of underreporting is there-
fore a major challenge for future research. 
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